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Site-specific DNA cleavage (SSDC) is a key step in many cellular processes, and it is crucial to gene editing. This work describes a kinetic assay
capable of measuring SSDC in many single DNA molecules simultaneously. Bead-tethered substrate DNAs, each containing a single copy of the
target sequence, are prepared in a microfluidic flow channel. An external magnet applies a weak force to the paramagnetic beads. The integrity
of up to 1,000 individual DNAs can be monitored by visualizing the microbeads under darkfield imaging using a wide-field, low magnification
objective. Injecting of a restriction endonuclease, Ndel, initiates the cleavage reaction. Video microscopy is used to record the exact moment

of each DNA cleavage by observing the frame in which the associated bead moves up and out of the focal plane of the objective. Frame-by-
frame bead counting quantifies the reaction, and an exponential fit determines the reaction rate. This method allows collection of quantitative and
statistically significant data on single molecule SSDC reactions in a single experiment.

Introduction

Site- specmc DNA cleavage (SSDC) is a key step in many genomic transactions. For example, bacterial restriction-modification (RM) and
CRISPR? systems protect cells from attack by phages and plasmids by recognizing and cleaving foreign DNA at specmc sequences. In type Il
RM, restriction endonucleases (REs) recognize short 4-8 base pair (bp) sequences via protein-nucleic acid |nteract|ons CRISPR-associated
endonucleases, such as Cas9, bind to sites via hybridization of the target site with crRNAs bound to the endonucleases”. The creation of
site-specific double stranded breaks (DSBs) are also the first step in many DNA recombination events®. For example the diversity of antigen
binding regions created by V(D)J recomblnatlon requires the recognition and cleavage of specific target sites®. Some transposons are known to
target specific DNA sequences, as well’, Not surprisingly, many site-specific nucleases involved in these processes such as Cas9 are a key
component of gene editing technologles In addition, novel site-specific endonucleases (i.e., zinc finger nucleases’ and TALENS' ) have also
been engineered to edit genomes.

Many methods have been employed to measure the kinetics of site-specific cleavage of nucleic acids. These include gel analysis,
fluorescence'"'?, and sequencing based methods'>. A major advancement was achieved with the tethering of microbeads, which allows DSBs in
single molecules of DNA to be detected by the motion of a bead after strand separation. In these methods, different types of forces are employed
to ensure strand separation and motion of the bead post-cleavage. In one case, optical traps have been used to measure cleavage of DNA by
EcoRV™. In these experiments, target search is the objective of the investigation, with conditions optimized so that site-specific binding is the
rate limiting step. One drawback of optical traps is that only a single DNA can be observed at a time. In addition, a periodic large pulling force
has to be applied to test for the strand separation.

Another technique uses a combination of flow and weak magnetic forces to pull on the bead in a continuous manner'®. In this way, diffusion
limited cleavage by Ndel is measured. The method employed allows for the simultaneous measurement of several hundred DNAs at once,
allowing for statistical significance to be attained in a single experiment. Experiments based on magnetlc tweezers have also been used. In

one such study, a retroviral integrase was studied by including a DSB in the insertion ollgonucleotlde . Successful integration resulted in the
incorporation of DSB in the tethered DNA and loss of the attached bead. In a similar study of the ATP-dependent type Il restriction endonuclease
EcoPl, tens of DNAs were observed in a single experlment Magnetic tweezers hold the advantage that tension, as well as DNA looping, can
be controlled and monitored during the reaction.

Presented here is a highly parallel single molecule method for measuring SSDC kinetics, which takes advantage of recent |mprovements in
large-scale tetherlng of DNAs. This method is an improvement and extension of previous methods used to measure DNA repllcatlon , contour
length of DNA'®, and cleavage by REs'®. In this technique, linear DNAs containing a single copy of the recognition sequence are prepared with
biotin at one end and digoxigenin at the other. The biotin binds streptavidin, which is covalently attached to a paramagnetic microbead. The
DNA-bead complexes are injected into a microfluidic channel that has been functionalized with anti-digoxigenin FAB fragments. The DNA then
tethers to the surface attachment points via binding of the digoxigenin to the adsorbed FAB fragments. Weak magnetic forces applied with a
permanent magnet keep the bead from sticking non-specifically to the surface. Samples can be injected rapidly (<30 s) into the flow channel to
activate the cleavage reaction. Flow is turned off during data collection. As each DNA is cleaved, the exact time of cleavage can be determined
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by recording the frame in which the bead moves up and out of the focal plan of the objective, thus disappearing from the video record. A frame-
by-frame count of remaining beads can be used to quantify the reaction progress.

Presented below is the complete protocol as well as example data collected using Ndel. As an example of how the technique can be applied,
cleavage rates for a range of protein concentrations are measured at two different concentrations of magnesium, an essential metal cofactor.
Although this application of the protocol uses Ndel, the method can be adapted for use with any site-specific nuclease by varying the DNA
substrate design.

1. Making the flow cell

1.

4.

5.

Washing the coverslips
1. Place coverslips in staining jars and sonicate with ethanol (EtOH), then with 1 M KOH (for 30 min each). To avoid KOH precipitation in
EtOH, rinse thoroughly with ddH,O between washes.
2. Repeat both EtOH and the KOH washing steps 1x for a total number of four washes (two EtOH and two KOH). Store cleaned
coverslips in ddH,0 in staining jars.

Cut loading and exit tubes (8 cm long) using a clean razor and insert into holes in a clean glass slide. Use PE-20 for inlet and PE-60 for
outlet. Epoxy for 5 min to secure tubing and trim off any excess tubing.

NOTE: Glass slides measure 2" x 3" x 1 mm. Holes are drilled in pairs 15 mm apart. Each pair forms either end of a single channel. The
tubing with the smaller ID is used for the inlet, as this reduces the upstream dead volume and thus the mixing time required (Figure 1).
Line up and apply precut double-sided tape with channel pattern cut out over holes on the glass slide. Smooth out with plastic forceps to
achieve a good seal.

NOTE: The double-sided tape used in this experiment is 120 um thick, and the channels are 2 mm wide and 15 mm long. Channels are cut
using a knife printer (Table of Materials). It is possible to fit up to four channels on a single coverslip. See Figure 1 for an image of the flow
cell.

After peeling off the backing, apply a clean coverslip (dried with compressed air) over the tape and smooth out again with plastic forceps for a
good seal.

Epoxy the edge off the coverslip to seal the flow cell and let it cure.

2. Preparation of labeled DNA for tethering

In a PCR tube, prepare 50 uL of PCR reaction mix containing 0.02 U/pL high fidelity DNA polymerase, 200 uM dNTPs, 0.5 pM forward
primer, 0.5 uM reverse primer, and 250 ng of M13mp18 vector DNA.

NOTE: Here, the forward primer (biotin-CCAACTTAATCGCCTTGC) and reverse primer (digoxigenin-TGACCATTAGATACATTTCGC) were
chosen to amplify a region approximately 1,000 bp long, spanning from positions 6338 to 107 in the circular genome of the M13mp18 DNA.
There is a single Ndel site in the middle of the amplified region. The forward primer is 5' labeled with digoxigenin, which binds the anti-
digoxigenin on the coverslip. The reverse primer is 5' labeled with biotin, which binds the streptavidin-coated beads.

Insert the PCR tube in thermocycler and follow the cycle as shown in Table 1.

Purify the PCR product with a PCR clean-up kit following the manufacturer's protocol.

NOTE: Using the kit specified in the Table of Materials, the typical DNA yield is ~2 pg.

3. Tethering of DNA and beads

10.

1.

Prepare 10 mL of buffer A (1 M Tris-HCI [pH = 7.5], 50 mM NacCl, 2 mM MgCl,, 1 mg/mL B-Casein, 1 mg/mL Pluronic F-127). Degas in a
vacuum desiccator for at least 1 h.

To functionalize flow cell, inject 25 pL of anti-digoxigenin FAB fragments (20 ug/mL) in PBS into the flow channel. Use gel loading tips to fit
into the PE-60 tubing. Incubate at room temperature (RT) for 30 min.

After incubation, flush the channel by pulling 0.5 mL of buffer A through the channel using a syringe. Take care not to introduce air into the
channel.

After functionalization, mount the flow cell on an inverted microscope. Hook up the outlet tube to a syringe pump and put the inlet tube into a
microcentrifuge tube containing buffer A.

Manually pull at least 0.5 mL of buffer A to flush the system and prime the pump. Let the pump run at 10 pL/min for at least 5 min to
equilibrate the system.

To prepare the beads (Table of Materials), vortex the stock bottle of beads and pipette 1.6 yL of the 10 mg/mL stock beads into 50 pL of
buffer A, then vortex.

Using a magnetic separator, pipette out the buffer and resuspend in 50 pL of buffer A, then vortex.

Repeat step 3.7 2x for a total of three washes. For the last wash, resuspend in 100 pL of buffer A and vortex to achieve a final concentration
of 160 ug/mL.

To complex the DNA and beads, first prepare 480 pL of 0.5 pM labeled DNA substrate in buffer A. Then, pipette in 20 pL of 160 uyg/mL bead
suspension, making sure to vortex the beads before pipetting. Place on a rotator for 3 min.

After 3 min, immediately load into channel at a flow rate of 10 yL/min for ~15 min or until sufficient bead tethering is observed.

NOTE: Beads should not be so densely packed that they interact with each other on the surface (see discussion section).

To wash the channel of all free beads, switch the inlet tube to a fresh tube of buffer A and flow in at 50 yL/min for at least 10 min or until no
loose beads are observed.
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4. Data collection and analysis

To prepare for data collection, place inlet tube into a microcentrifuge tube containing at least 100 pL of Ndel (0.25—4.00 U/mL) in buffer A.
Lower the permanent magnet over the flow channel, and position the light source off axis for darkfield imaging.

NOTE: Two annular rare earth magnets, epoxied together, are held 8 mm above the active surface of the flow channel using a cantilevered
optical post during data collection. A goose neck lamp is used for the off-axis light course.

Use a commercial microscope, video camera, and data collection software (Table of Materials). In the software, click the "Exposure" tab,
and set "Exposure Time" to 10 ms. Click "Timelapse" tab and set "Image Count" to 600, "Duration" to 20 min, and "Interval" to 2 s. Click
"Run" to start data collection.

On a syringe pump, set the flow rate to 150 yL/min and injection volume to 80 pL. Press "Run" at 1 min into data collection. After injection,
turn off the pump and close the valve to prevent flow during data collection.

Once data is collected, open image analysis software (Table of Materials). Under the "File" tab, choose "Import" | "Image Sequence".
Locate the image files in the pop-up menu and click "Open".

Set the threshold by choosing "Adjust Theshold" under the "Image" pull-down menu. Use the slider bar to set the threshold value to identify
bright spots corresponding to beads in the image.

Count the bright spots in each frame by clicking "Analyze Particles" in the "Analyze" pull-down menu. Click "OK", then choose "Yes" to
process all images. Save the results file.

NOTE: This will save a data file that contains the number of beads in each recorded video frame.

Open data analysis software (Table of Materials) and import the results file by clicking "Import from Test File" in the "File" pull-down menu.
Plot the bead count data vs. time.

Fit the number of beads vs. time by clicking "Curve Fit" in the "Analyze" pull-down menu. Choose the "Natural Exponent" equation and click
"Try Fit" | "OK".

NOTE: Only the data recorded after the injection of sample should be included in the fitting region. The fit parameter in the exponent of the
fitting function will be the cleavage rate.

Representative Results

Using this technique, the SSDC rates of Ndel were measured for a range of protein concentrations (0.25—4.00 U/mL) at two different
concentrations of magnesium (2 mM and 4 mM). Each of these conditions was replicated at least twice, with a few hundred to 1,000 tethered
DNAs per experiment. Figure 2 describes the experimental design. Figure 3 shows examples of data collection and analysis details. Figure

4 illustrates how the rate depends on protein concentration at the two concentrations of magnesium. It can be observed that at sufficiently low
protein concentrations, the rate is proportional to protein and independent of magnesium. For sufficiently high protein concentrations, the rate is
dependent on magnesium but independent of protein concentration.

Step Description Temperature (°C) Time (s)
1 Denaturation 98 30

2 Melt 98 10

3 Anneal 60 30

4 Extend 72 30

5 Final Extend 72 120

Table 1: PCR parameters. Shown are temperatures and durations of the thermocycler program steps used in step 2.2 of the protocol. The melt,
anneal, and extend steps (steps 2, 3, and 4) are repeated 30x.
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Figure 1: Microfluidic flow cell construction.

The top glass slide (2" x 3", 1 mm thick) is pre-drilled with holes matching the channel pattern. The inlet and outlet tubes are inserted into the
holes and fixed with epoxy prior to attaching tape and cover glass. The double-sided tape is pre-cut with channel pattern. The bottom slide (#1 or
#1.5 cover glass) is previously cleaned using the protocol described in the main text. Once assembled, the edge of the cover glass is sealed with
epoxy. Please click here to view a larger version of this figure.
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Figure 2: Experimental design.

(A) Method of DNA tethering. Double-stranded DNA (1 kbp) labeled with digoxigenin on the 5' end is attached to the surface of the flow cell via
antidigoxigenin-digoxigenin interaction. The 3' end of the DNA, labeled with biotin, is attached to a microbead via streptavidin-biotin interaction.
The Ndel cleavage site is located at the center of the DNA. (B) Experimental setup during data collection showing magnet and objective position.
The permanent magnet maintains a weak upward force on the bead during the cleavage reaction. Please click here to view a larger version of
this figure.
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Figure 3: Example of data collection and analysis.

(A) Image of region of beads taken before cleavage reaction is initiated. (B) Image of same region after reaction is completed. (C) Plot of number
of beads vs. time (black curve) as determined from each frame of the video record. The shaded green area marks the period of injection of
enzyme and is not included in the fit. The data fits a single exponential curve (dashed green curve), with a decay constant equal to the reaction
rate. Please click here to view a larger version of this figure.
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Figure 4: Ndel cleavage is dependent on concentrations of protein and magnesium.

Plot of the measured SSDC rate of Ndel for a range of protein concentrations at two different concentrations of magnesium: 2 mM (blue circles)
and 4 mM (green squares). Error bars represent SEM. The dashed curves are trend lines and do not represent fits to theory. Please click here to
view a larger version of this figure.

The protocol can be used to measure the kinetics of any SSDC system, provided that the strand separation is observed during the experiment.
The detection of cleavage is affected by observing the detachment of the tethered bead and therefore marks the instant of strand separation. All
preceding steps occur before the detection of the cleavage; thus, only the total transit time is recorded.

The flow cell coverslip is functionalized via non-specific adsorption of antibody protein to the clean glass. Insufficiently cleaned glass may affect
binding of the antibody. In tethering, bead density should be low enough so that beads do not interact. The surface density of attachment points
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can be controlled by the concentration of antibody during functionalization. The total number of beads depends on the size of the field of view. In
this case, a few hundred to 1,000 tethered beads were sufficient for good statistics and avoided bead-bead interactions. During bead injection,
surface tethering was monitored via live video. Bead injection was stopped when estimated bead count was between 500 and 1,000 beads.

The fastest cleavage rates that can be accurately measured are limited by the mixing time of the flow cell. The mixing time in laminar flow cells
is influenced by several factors. Diffusion to the surface is a key step; therefore, the mixing time depends on the diffusion coefficient of the
reactant. The significant shear that occurs in the entrance tubing, which transports the sample to the flow channel from the sample reservoir, can
increase the time needed to ensure adequate mixing at the reaction surface in the channel. It was found that the mixing time could be reduced
by reducing the upstream dead volume and increasing the flow rate. With an inner diameter of 380 ym and maximum length of 8 cm for the

inlet tubing (and flow rate of 150 yL/min), it was found that the injection time could be reduced to ~20 s without affecting the measured cleavage
rate. Since the mixing time depends on the diffusion coefficient of the reactant, it should be determined separately for each enzyme or cleavage
activator studied.

The tethering method allows for non-specific tether rupture, presumably due to either dissociation of the digoxigenin-antibody complex or release
of the antibody from the surface. This results in a reproducible background bead loss rate present before the injection of enzyme of ~3 x 10*

s™ . This systematic effect can be corrected for either by subtracting the background rate from the measured cleavage rate, or by modeling the
background in the fitting equation. However, cleavage rates lower than this lower bound will be less reliably measured.

Imperfect surface passivation can lead to improper tethering. This leads either to increased fractions of "stuck" beads, which do not go away
during the the experiment, or to beads, which dissociate from the surface very slowly. This creates a higher and possibly sloping baseline in the
processed data. It was found that with properly cleaned cover slips and freshly made B-casein stock solution, these effects were minimal for most
data sets. For the occasional data sets that show this, modifying the fitting function (to include a sloping baseline) can correct for this effect.

The current protocol can be extended in several ways. Further isolation of mechanistic steps after target site binding can be performed using

a pre-binding format, in which protein is injected in the absence of essential cofactors. This idea is tested by injecting Ndel in the absence of
magnesium. Under these conditions, the protein binds to its cognate site but does not cleave the DNA. Injecting magnesium after this binding
step activated the cleavage resulting in rapid bead loss. The experimental setup also allows for the control of DNA conformation and tension
by varying the magnet configuration or adding flow. Under the low forces in these experiments, the DNA becomes partially coiled. Changing
the forces slightly can have a dramatic effect on the conformation of the DNA. For example, under buffer conditions in which target search is
rate limiting, varying the conformation of the DNA can test for the effect of jumping on the target search. Under buffer conditions in which the
hydrolysis step is rate-limiting, varying the force can probe the effect of the DNA tension on phosphodiester bond hydrolysis. It should be noted
that under the low magnification used, these conformational changes cannot be observed. The resulting small motions in bead position have to
be tracked under higher magnification to verify that DNA conformation can be controlled.

Data analysis can be extended in a variety of ways. This work applies a simple bead counting method followed by curve fitting of a single
exponential function. Methods based on residence time analysis can be used, as well®. Distributions of residence times of individual DNAs can
then be analyzed via curve fitting or by using more sophisticated techniques, such as the generalized method of moments?'.
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